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Foreword

A Brief History of Presentations

Step back in time more than 40,000 years to the banks of a stream in what is now 

southeastern France. The leader of a tribe of cave dwellers is addressing the chiefs of four 

neighboring tribes that have been battling each other for generations. Language has not yet 

fully formed, and he struggles to communicate the revolutionary idea in his mind. It is an 

idea that could change the entire world as they know it. 

Of the scarce few words at his command, there are none for intangibles like peace, 

coexistence, or shared destiny. In frustration, he draws an arrow from his quiver, kneels, 

and deliberately traces a series of lines in the sand. The other men watch intently, confusion 

giving way to cautious nods as the shapes emerge into a map of the surrounding terrain. 

Then the tip of the spear divides the map with new boundaries. The size of each new region 

is nearly equal. The natural resources are split almost evenly between them. In silence, 

each man ponders the shocking idea of voluntarily reshaping his tribe’s ancestral territory. 

Within a few minutes there is agreement. The men look probingly into one another’s eyes, 

and conclude their treaty by slowly nodding in unison. This is not only one of the fi rst such 

peace councils in the history of humankind but also among the earliest presentations.

Fast forward to April 17, 1492, some 500 miles to the southwest. Christopher Columbus 

stands before Isabella, Queen of Castile, holding a map showing the continents of Europe 

and Africa on the right and Asia on the left, with little but ocean between them. When the 

dashing Genoese navigator fi nishes, Isabella asks several pointed questions, but the huge 

potential return on investment is tantalizing. She wastes little time in agreeing to sponsor 

the mission. Here we witness the green-lighting of arguably the single most momentous 

expedition ever undertaken. As it happens, this also marks a very early use of a visual aid 

produced on a printing press, which had been invented only four decades earlier.

Our next step ahead in time covers just 400 years. Thomas Edison is making a pitch to a 

small group of investors in Manhattan whom he hopes will help fund the construction of 

a factory to mass-produce light bulbs. They assume that the prototype bulb that glows 

above Edison’s head is his one and only exhibit, so they are surprised when the inventor 

turns it off and his assistant switches on another light inside a box at the back of the room. 
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Projected on the wall in front of them is a ghostly image taken along the Mohawk River near 

Schenectady, New York. The deal that the men draft later that afternoon both secures the 

future of Edison’s great breakthrough and launches a new corporation, General Electric. His 

presentation, too, is noteworthy for the use of a projected photographic image in a meeting 

of global consequence.

The technology of projecting images continues to advance rapidly from the Magic Lantern 

used by Edison. By the 1950s, a quiet yet determined researcher named Jonas Salk is 

using a primitive mechanical slide projector in his campaign for universal immunization to 

eradicate polio. The combination of heart-wrenching images of children in steel leg braces 

and charts illustrating clear results helps him overcome widespread fear of a vaccine made 

from the very virus that causes the disease. Just a decade later, professors of electrical 

engineering rely on mass-produced Bell & Howell overhead projectors to teach the 

fundamentals of integrated circuits to a generation of promising young engineers. These 

students will go on to develop the chips at the heart of the computer that you use to give 

PowerPoint presentations, and on which you will soon be using Ovation.

While elements of these vignettes may be more apocryphal than literal, the point remains 

that every undertaking worthy of note begins as merely an idea — an idea that can only 

grow into action when it is effectively communicated to others. Whether the goal is to 

inform, motivate, inspire, or simply share a vision of the future, effectively delivering your 

message is crucial to your success. 

The Future of Presentations

How does the software you now hold in your hands fi gure into the future of presentations? 

At Serious Magic, we believe that the evolution of presentations will entail signifi cantly 

enhanced visuals as well as new tools that help improve a presenter’s delivery, so we 

developed Ovation to offer major new capabilities in these two fundamental areas. It 

dramatically improves the appearance of your presentation, letting you choose the degree 

of visual enhancement, from subtly polished to vibrantly dynamic. It also provides tools that 

help you deliver that presentation more effectively. If you take full advantage of Ovation’s 

presenter tools, they will help ensure that you confi dently hit all the points you wanted to 

cover. They will allow you to drill deeper on issues that interest your audience. And they will 

help improve your pacing, so that you don’t end up having to rush through key material at 
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the end of the presentation. Combined, Ovation’s features can help you enhance the overall 

impact of your presentations and, in so doing, achieve your objectives.

To us, Ovation is more than just a commercial product. It is also a singular technical 

achievement, a unique work of art and, ultimately, a labor of love. It began years ago when 

a talented team was assembled from a range of disciplines to build a new kind of tool. 

Software architects and engineers crafted a highly optimized graphics engine capable of 

rendering imagery from the sublime to the spectacular. Artists and designers started with a 

blank page and envisioned how the visuals for future presentations might look. Then they 

painstakingly breathed life into those visions by modeling, texturing, and animating pixels 

and polygons until they became art in motion.

In the end, all that really matters is what Ovation does for you. Our hope is that it makes 

you more successful by helping you deliver your messages more effectively. After all, 

more than 30 million presentations are delivered every business day. Now some of those 

will be Ovation powered. It’s an exciting thought. Every time Ovation helps you delight 

someone with a touch of grace and elegance on the screen, each time an audience senses 

the extra poise and confi dence in your delivery, we’ll be cheering you on. If Ovation helps 

your presentation stand above the rest, if tomorrow’s audiences are more captivated than 

yesterday’s, then together we will have succeeded.

— The Serious Magic Team 
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Introduction

The basic idea behind Ovation is simple. It is a player for PowerPoint shows that 

“re-imagines” your slides on-the-fl y into a more polished and professional presentation. 

The result is to give you the benefi ts of hiring a team of expert graphic designers and 

animators to create a custom presentation for you—without spending thousands of 

dollars and enduring weeks of delay. While the fi nished output can range from subtly 

sophisticated to dynamically dazzling, the process remains easy because you still create 

your presentations in PowerPoint. 

Ovation also introduces several highly effective tools to help you be a better presenter. 

By using your computer’s dual screen output capability, the program displays the full-

screen output to your audience while you’re running the show through Ovation’s interface. 

Its presentation tools help you stay on time and on point. To aid in keeping on schedule, 

Ovation has not only a timer that can count up or down but also a TimeKeeper, which 

shows at a glance whether you’re running too slow, too fast, or just right. To ensure that 

you cover all your material, the PointPrompter displays your notes for each slide in large, 

easy-to-read text.
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Getting Started

 Installing 
Insert the Ovation Installation disc into your PC’s CD drive and wait for the installer to 

launch. If the installer does not launch automatically, use Windows Explorer to view the 

contents of the CD and double-click the Setup.exe fi le. Follow the instructions in the wizard.  

Before installing Ovation, make sure that your computer meets the following  requirements:

• Operating System: Windows® XP or 2000 

• Processor:

Minimum: Intel® Pentium® 4 / Celeron class 1.6GHz, 

Pentium® M / Celeron M 1.2GHz, or AMD® Athlon™ 1600

Recommended:

- Pentium® 4 / Celeron 2.4GHz

- Pentium® M / Celeron M 1.7GHz

- AMD® Athlon™ 2400

• RAM: 256 MB (512 MB recommended) 

•  Graphics Processor:

Minimum: Any nVIDIA® GeForce™, ATI® Radeon®, or Intel® Extreme or better graphics 

processor with 32 MB of graphics memory

Recommended:

- ATI® Radeon® 9800 class or better

- nVIDIA® GeForce® 6600 class or better

- 64 MB of graphics memory

• CD-ROM drive

• 450 MB available hard drive space 

• Microsoft®  PowerPoint® 2002 (XP), 2003, or newer 

(PowerPoint is also part of Microsoft Offi ce™)

If Microsoft PowerPoint® 2002 or newer is not installed, you will not be able to import  

presentations into Ovation. The installation wizard will alert you if PowerPoint is not present, 

but you can proceed with installation regardless.
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Quick Start
The shortest path to getting a show running in Ovation takes just three steps:

1. Load a PowerPoint presentation into Ovation.

2. Choose a look for the show.

3. Deliver the presentation.

Of course, Ovation has a host of features and options for improving both the look of your 

presentations and your delivery of them, but everything beyond these three basic steps is 

entirely optional.

The section titled The Fundamentals provides complete instructions for these three steps, 

but we’ve boiled them down to the essentials here.

Loading a PowerPoint® Show in Ovation
Drag and drop a PowerPoint fi le (.ppt) onto the Ovation icon on your desktop. If you 

don’t have a slide show handy, use the Ovation Example show that was installed on your 

desktop. To learn three other ways to load a show, see Launching and Loading on

page 18.

 Selecting a PowerLook™ 
On the Choose Look panel, select a category in the pane on the left, then click a 

PowerLook in the pane on the right. (If the selected category shows a set of folders instead 

of PowerLooks, double-click one of the folders to open it.) You can immediately preview the 

look in the preview monitor on the far right.

Loading a Look may take a moment: If your computer has an older graphics card, then 

Ovation will optimize the PowerLook to deliver smoother performance on your machine 

when you are presenting. Depending on the speed of your computer, this optimization 

might take up to several minutes. 

Something Amiss? Tweak the Treatment: Ovation’s marvelous graphical feats can 

change the layout and all aspects of the font treatment for your slides. In performing 

this makeover, Ovation will determine how far it can go in overhauling each slide. If you 
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don’t like the treatment of a given slide, you can override Ovation’s enhancements by 

right-clicking the slide’s thumbnail on the Navigation Bar and selecting one or more of 

the options to revert to the PowerPoint design. You can also make these changes on a 

show-wide basis through the Ovation Treatment for Show submenu of the Tools Menu. 

These options are fairly self-explanatory, but you can learn more about them on the 

Customizing a Look and Fine-Tuning the Ovation Treatment page in the Advanced 

Features/Setting Up section of the online help. 

Delivering a Show
To begin presenting, click the Start button. If your computer is running with only one 

screen, then your slides will be shown full screen, hiding the Ovation interface. To switch 

back to the Ovation window, press the Escape key. To learn about operating in dual-screen 

mode, please consult Dual Display Setup on page 29.

You can navigate from bullet to bullet and slide to slide using the same basic navigation 

keys as in PowerPoint: SPACEBAR to advance to the next item, left arrow to move back 

a slide, etc. The Next and Back buttons on the Present panel step forward and backward 

through bullets and slides.

To learn more about Presentation Assist features such as Deeper, TimeKeeper, and the 

PointPrompter, continue reading the Feature Overview section.



10



11

Feature Overview

PowerLooks™ 

PowerLooks are exclusive Ovation design packages that give your presentations a distinctive 

look and feel. They’re the graphical ensembles that re-imagine your shows, bringing them to 

life with dynamic, visually compelling artistic treatments. PowerLooks are conceptually similar 

to PowerPoint® themes or templates in that PowerLooks defi ne the color, design, and layout 

of a slide. However, PowerLooks go far beyond standard themes because a PowerLook can 

do many things that simply aren’t possible in PowerPoint, from animating backgrounds, to 

superimposing dynamic textures across text faces, to adding glows and streaks of light. 

Ovation comes with scores of PowerLooks, and we’re always developing more. They range 

from subtle and understated to eye-catching, high-impact looks.

There are two ways to assign a PowerLook to a presentation:

• Select one from the library on the Choose Look tab. The left-hand pane allows you to 

fi lter which looks are shown in the library. 

• Pick an Ovation PowerLook as the template when you’re creating the show in 

PowerPoint. To learn more about working with Ovation looks in PowerPoint, please 

consult Selecting a PowerLook on page 19.

See also in the online help:

• Selecting the Look for your Show (in section titled The Fundamentals) 

• Applying an Ovation Template within PowerPoint (Designing in PowerPoint/Slide Design 

and Revising Slide Content and Updating)

• Customizing a PowerLook (Advanced Features/Setting Up)
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Deeper
One thing that sets great presenters apart from the pack is that they anticipate questions 

and prepare slides to illustrate their seemingly “off-the-cuff” answers. Ovation’s Deeper 

feature puts such supplementary graphics at your fi ngertips. You can think of going deeper 

as taking an optional one-step detour from the show’s main slide sequence to content 

that you assigned to the current slide prior to beginning the presentation. You can assign 

either another slide from the same show or an image as deeper content. The slide to which 

deeper content is assigned is called the “parent slide.”

To assign deeper content, right-click the parent slide and select Add Deeper from the 

Popup Menu. Please consult Assigning Deeper Content in the Advanced Features/

Setting Up section of the online help to learn more about creating these links.

To jump to the deeper content, click  Go Deeper on the Present control panel. (If the button 

reads “ Add Deeper,” then the current slide has no deeper content assigned.) From the 

deeper content, you can either return to the parent slide or proceed to the next slide in the 

main sequence using the standard navigation commands. Please consult Going Deeper in 

the Advanced Features/Presenting section of the online help for more on how to navigate 

to and from deeper content.

The  TimeKeeper™ 

Ovation has the almost magical ability to eliminate one major source of presentation-

induced stress: the worry that you’re running dreadfully behind schedule or perhaps racing 

through your material far too fast. The TimeKeeper shows you at a glance how close you 

are to your desired pace. With this feedback, you can make little adjustments along the way 

so you don’t end up frantically rushing through your last few slides. It’s like a safety net that 

lets you stay relaxed, confi dent, and focused on other aspects of your presentation.
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The TimeKeeper, which sits at the top of the Present control panel, has two bars. The top 

one represents the show’s total length, which you set by clicking the TimeKeeper and 

typing the  Target Show Duration in the edit fi eld that opens. When you click Start, a clock 

icon appears and starts moving steadily to the right. The bottom bar shows you which 

slide you’re on. The blocks that it’s divided into represent all slides that are enabled. As you 

advance through the presentation, the current slide is highlighted and adorned with the icon 

of a person to show you which slide you’re on. The relative width of each block represents 

the time budgeted for that slide. So, for instance, the block for a 4 minute slide will be twice 

as wide as that for a 2 minute slide.

If you’re right on schedule, you’ll transition from one slide to the next just as the Progress 

Bar passes the line separating the two slides on the Current Position Bar. The Progress Bar 

will turn from blue to red if you start falling behind, indicating at a glance that you need to 

pick up the pace.

Spending about the same amount of time on each slide is a good general goal, but 

since material rarely breaks down that evenly, Ovation lets you independently set the 

time budgeted for each slide. Just click the time or “--:--” on the slide’s tab in the Slide 

Navigation Bar along the bottom of the window. If you’ve set a target show duration, then 

Ovation will calculate times for slides that you haven’t set times for. When you import a 

show for the fi rst time, Ovation will apply any slide times that you set in PowerPoint. It can 

also learn slide timings as you rehearse the presentation or deliver it for real. 

PointPrompter™ 

The PointPrompter is a like a stack of virtual note cards that can operate as a teleprompter 

just like television newscasters use to speak more confi dently. You can use the 

PointPrompter to show an outline of key points or a verbatim script, and you can move 

about in it manually using the scrollbar or have it scroll at the speed that you set. Ovation 

imports notes from PowerPoint if you’ve entered them in the Notes fi eld, which sits below 

the slide preview in the Normal and Notes Page views. 

To learn more about the PointPrompter, please consult Setting Up/Preparing the 

PointPrompter and Presenting/ Scrolling the Note Card, Rolling the TelePrompter in 

the Advanced Features section of the online help.
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Special Purpose Slides 
As a rule, Ovation works with slides that you 

created in PowerPoint. Like most good rules, 

however, this one has exceptions. Ovation allows 

you to add four types of special purpose slides: 

• The  Walk-In and Walk-Out slides are like 

bookends for your presentation—pleasant 

graphics for your audience to look at 

as they’re assembling beforehand and 

dispersing afterwards. You can add a 

few words of greeting or perhaps a brief 

message to pique their interest, whet 

their appetites, and get them thinking. 

Since these two slides may be shown for 

an undefi ned period, they do not have slide times and are not included in the show 

duration or represented on the TimeKeeper.

• The  Introduction slide displays the title or topic of the presentation as well as your 

name and contact information.

•  Intermission slides not only carry the PowerLook through scheduled breaks but also 

show how long until you resume.

Each PowerLook has variations on its theme to give these bonus slides a unique look. 

Adding these slides through Ovation has the advantage that they’re not in the slideshow on 

the PowerPoint side when you go to print handouts. 

You add these slides and enter their text through their own tab under Options. To learn more 

about them, please consult Adding Special Slides in the Advanced Features/Setting Up 

section of the online help.
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Adding Your Own Graphics to the Look
So you’re enraptured by Ovation’s stunning 

PowerLooks but want to work your own logo 

or branding into the mix? Perhaps policy calls 

for your company logo or university seal to be 

displayed. Not a problem. On the Customize 

Look control panel under the Options Tab, 

you can add your own graphics. Ovation will 

fold them seamlessly into the PowerLook. You 

control the transparency to get just the right 

effect. To learn how each type of image is 

handled as well as the options that are available, 

please consult Customizing a PowerLook in 

the Advanced Features/Setting Up section of 

the online help.
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The Fundamentals 

This section covers the essential steps necessary to give a PowerPoint® slideshow an 

Ovation makeover and then to present that show through Ovation. It’s as easy as 1, 2, 3:

1. Launch Ovation and load a PowerPoint presentation. (Yes, these are two steps, but 

Ovation gives you a couple of ways to accomplish both with a single action.)

Select a Look for your presentation. (Not necessary if you either assigned an Ovation 

template through PowerPoint or are content with the default theme.)

Present the show.

Making it as easy as 1: That’s right. You can reduce the three fundamental steps 

outlined here to just one by enabling the  Start Presenting upon Loading Show 

option in the Application Settings Dialog (open with ALT+S). Then when you drag 

and load a PowerPoint fi le, all of the following steps will be carried out automatically 

without so much as a click from you.

• Ovation will launch.

• The show will load.

• If a PowerLook is not yet assigned, then the 

default Look will be applied.

• The fi rst slide will be shown full-screen.

• If you are set up for dual display, the Present control panel will open.

• The TimeKeeper will start running (if a Target Show Duration was previously set, 

and if the Walk-In slide is not enabled).
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Launching Ovation and  Loading a Presentation
You can launch Ovation and load a PowerPoint show in any of the following four ways (the 

fi rst three accomplish both steps with one action):

• Drag and drop a PowerPoint fi le (.ppt) onto the Ovation icon on your desktop.

• Right-click the show’s fi lename and select Open with Ovation from the popup menu.

• With the show open in PowerPoint, click the Go to Ovation button on the toolbar. 

If this toolbar is not displayed, right-click anywhere on the PowerPoint toolbars and 

select Ovation from the list in the popup menu.

• Launch Ovation by double-clicking its icon on your desktop (or by selecting it from the 

Start Menu under Programs > Serious Magic Ovation). If this is the fi rst time you’ve 

run Ovation, then it will prompt you to browse to a PowerPoint presentation and open 

it. If you’ve used Ovation before, you’ll see a Select Show dialog, which displays a list 

of the presentations you’ve recently opened in Ovation. If the desired presentation is 

not in the list, click the Browse button to fi nd it.

To switch to another show within Ovation, select Open in the File Menu and browse to the 

desired PowerPoint fi le. If it’s a show you’ve had open recently, you can also select it from 

the Recent Shows submenu of the File Menu.

When Ovation opens a PowerPoint fi le, it checks whether it has previously loaded the show 

and, if so, applies all the saved information such as slide times and custom graphics.
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Selecting a  PowerLook for Your Presentation
Ovation comes with a large library of PowerLooks. The built-in categories make it easy to 

fi nd one that gives your show a suitable look. You can also assemble a custom list of your 

favorites. To fi nd and apply a look:

1. Click the Choose Look tab.

2. Select the desired category in the pane on 

the left.

3. If the selected category displays a batch of 

folders in the Library pane, double-click one of 

them to open it.

4. Click the icon for the desired look. The preview window will show you the treatment 

for the current slide. To see how bullets and other elements are animated and 

highlighted, press the SPACEBAR just as you would when presenting. To preview the 

look full screen, press the Escape key. Most PowerLooks display various types of 

content in different w ays, so if the presentation has a variety of slide types, be sure 

to preview a sampling of them before settling on a look. 

You can also assign a PowerLook as a design template within PowerPoint. This has several 

benefi ts:

• Ovation will automatically apply that look upon importing the show.

• If you know a slide is going to use the original layout, then you have the PowerLook’s 

design to guide you as you arrange the slide’s content. By default, presentations 

with an Ovation design template assigned will automatically use the full PowerLook 

background for slides that use the original layout. This maintains consistency 

between the look of reverted slides and those that get the full Ovation treatment. 

• Ovation’s design templates use the same font as the corresponding PowerLook. 

The font color is also a close approximation, but in many cases it can’t be identical 

because PowerPoint does not support gradients like those Ovation uses for text 

treatments. As with the layout, having the typeface and its color the same in 

PowerPoint as in Ovation improves consistency for slides that are set to use the 

original typeface or font color.

Select Category 
Here

Select PowerLook 
Here
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To fi nd Ovation’s templates in PowerPoint, select  Design Templates on the Slide Design 

page and click Browse at the bottom of the pane, then open the Ovation folder in the Apply 

Design Template dialog. (If the Design Templates pane isn’t open, click the Slide Design 

button on the Formatting toolbar.) Once you’ve applied any look from this folder, 

icons for all of them will be folded into the main Design Template bin. 

As easy as assigning a look is, it may not even be necessary. That’s because your show 

may already be dressed in the look you want as soon as you import the PowerPoint fi le. 

Upon initially loading a show, Ovation automatically assigns a look to it according to the 

following criteria:

• If an  Ovation design template was assigned in PowerPoint, then the corresponding 

PowerLook will be used.

• If an Ovation look was not assigned within PowerPoint, then the program checks 

whether the Apply Last Look for New Shows option is enabled in the Application 

Settings Dialog. If it is, then the look from the last show you opened will be used.

• If neither of the above conditions is met, then the default look will be assigned. 

 Setting the Default Look
Right click the icon for the desired look and select Set this Look as the Default.

 Adding a Look to Favorites
To add a PowerLook to the Favorites group, either right-click it and select Add Favorites 

list or click and drag it to from the PowerLooks box to the Favorites icon. To remove one 

from the Favorites group, right-click it and select Delete from Favorites.

 Getting More PowerLooks
We are constantly developing new PowerLooks for Ovation. To check out what’s available, 

click See More Looks on the Choose Look panel. 

Other Setup Steps
Beyond selecting a look, there are several other options for setting up and customizing 

your presentation. For instance, you may want to assign times to individual slides or 

specify a Target Show Duration. For instructions on all the setup options, please consult the 

Advanced Features/Setting Up section in the online help.
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Presenting
 Starting the Presentation
To take it from the top, click the Start button or press F5. If you’re working with dual 

monitors, this causes several things to happen:

• The fi rst slide will be displayed full screen.

• If you’re not already on the Present Tab, then the program switches to that panel.

• The TimeKeeper will start running if either the Target Show Duration is set or all slides 

have a custom time. If the Walk-In slide is enabled, then the TimeKeeper will not start 

until you advance to the next slide.

• If the Clock is set to Count Down or Count Up, then it will begin running accordingly. 

As with the TimeKeeper, if the Walk-In Slide is enabled then the clock will wait until 

you advance to the next slide.

If you’re running with a single display, then all these things will still happen, but by default 

Ovation displays the full-screen output, so you won’t see the program’s interface. To toggle 

between full screen and the interface, press the Escape key.

Regardless of whether you have one or two displays, you can keep Ovation from showing 

the full screen output when you start presenting by disabling the Show Full Screen while 

Presenting option on the Hardware Setup tab of the Application Settings dialog.

You can also start either from the slide that’s currently selected on the  Slide Navigation 

Bar by pressing F6 or from any slide by right-clicking it and selecting Start Presentation 

from This Slide. All preceding slides except the Walk-In and Introduction slides will be 

temporarily disabled and removed from the TimeKeeper.

Cutting to the Chase: Ovation gives you the option of 

jumping straight into presenting immediately upon loading 

a show. To enable this option, select the Start Presenting 

upon Loading Show option in the Application Settings 

dialog (ALT+S). If this option is active, you can of course click 

Stop at any time. (See also: Appendix: Dual Display Setup)
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  Auto-Advancing Based on Slide Times—The  Kiosk Mode
If times are set for all slides, then you can have Ovation automatically advance through 

the slides based on those times. With slides that have animation applied, the slide time is 

divided evenly among the animation steps. All navigation options remain functional when a 

presentation is running in this mode.

To run a presentation in this way, which is known as the “kiosk mode,” select Auto-

Advance in the Presenter Menu. Ovation will enter the presenting mode just as if you had 

clicked Start, the only difference being that slides will advance automatically.

By default, a presentation that’s running in the kiosk mode will loop endlessly until you stop 

it. To set Ovation to play shows only once, disable the Loop Continuously in Kiosk Mode 

option on the General Tab of the Application Settings dialog.
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Navigating
Ovation allows the following navigational steps. Note that if you’re running the presentation 

with a single monitor in the full-screen mode, then you’ll naturally have to use the keyboard 

shortcuts since the Ovation interface will not be visible.

Action By Mouse By Keyboard What Happens

Next Element  Next button Spacebar  Advances to the next element.

Back in History  Back button Backspace If you advanced normally to your current 

position, then this backtracks element by 

element. If you’ve jumped around, then 

Back retraces those steps. 

If you’re on Deeper content, then this 

action returns to the parent slide.

Next Revealed 

Element

CTRL+Down 

Arrow

If the slide has animated content and 

two or more elements are revealed, then 

these actions move the focus to the next 

or previous element, pausing video or 

audio that is playing.

Previous Revealed 

Element

CTRL+Up 

Arrow

Next Slide CTRL+Right 

Arrow

Advances to the next enabled slide in the 

show.

Previous Slide CTRL+Left 

Arrow

Goes back to the previous enabled slide 

in the show.

Show All Elements CTRL+A If the current slide contains animation 

steps, this reveals all of them at once.

Show Deeper 

Content

Go Deeper button D If the current slide has Deeper Content 

assigned, it gets displayed.

Random Slide 

Access

Click any slide 

thumbnail on 

Navigation Bar

Type the slide’s 

number

This allows you to deviate from the main 

slide sequence. You can even display a 

disabled slide in this manner.
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Playing Video and Audio Clips
If an audio or video video clip is linked to a slide, it will begin playing automatically upon 

advancing to the slide or the animation step within the slide to which it is linked.

Advancing to the previous or next animation step or slide stops and resets the clip. 

On a slide with at least two animation steps revealsed, you can pause the clip without 

resetting it by moving the focus to the previous or next element, which you do by pressing 

CTRL+Up Arrow or CTRL+Down Arrow.

If a clip was set to loop in PowerPoint, then it will loop in Ovation until you take an action 

to stop it.

If you switch to another program while a clip is playing, the audio will continue playing. 

The video, however, will pause along with the dynamic background.

Go to  Black or  White
To switch to a black screen, press “B” on your keyboard. To switch to a white screen, 

press the “W.”

To return to displaying the current slide, press the same key again.

 Stopping a Presentation
When Ovation is in the presentation mode, the Start button becomes the Stop button. 

Clicking it or pressing F7 terminates the full screen output, resets the TimeKeeper, and 

returns the clock to displaying the time of day.

To hide the full-screen display temporarily without resetting the show, press Escape.

Saving
Ovation automatically  saves the settings for each presentation. This avoids the need to 

save Ovation’s show settings manually. 
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Exporting for  Sharing
To make an Ovation slide show available for copying or sending to another system, click 

Export in the File Menu. This opens a standard Save As dialog through which you can 

specify the name of the exported fi le and the path to which it will be saved. 

The resulting fi le, which has an extension of “.ovn,” is a self-contained presentation that you 

can load on any system that has Ovation or the Ovation Player installed. If the presentation 

contains any linked audio or video clips, be sure to copy the fi les for those clips along with 

the exported show and put them all in the same folder.

On the second system, you can make any changes you like within Ovation (slide times, 

special purpose slides, etc.). However, you will not be able to access or revise the original 

PowerPoint fi le from the exported version in fact, PowerPoint does not even have to be 

installed on the second system. If it’s necessary to edit the slide content, you can either do 

so on the originating computer and re-export the presentation or copy the PowerPoint fi le 

to the second machine, import it into Ovation, and redo any customization.

On the second system, load the exported presentation fi le by any of the standard methods:

• Drag and drop it on Ovation’s desktop icon.

• Right-click the fi lename and select Open with Ovation.

• Launch Ovation and browse to the exported presentation fi le.

If revisions to the fi le cannot be saved, then Ovation will prompt you to set a path where 

it can save changes. If you opt not to set a new path, then any changes you make to the 

presentation within Ovation will not be saved. Assuming the exported fi le is writable, you 

can copy it to another computer without re-exporting it.
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More Help Online

This printed manual is a digest of the online help that focuses on the most essential tasks. 

The online help includes the following additional content. It is also updated periodically and 

included in free updates of the software.

Orientation to Ovation’s Interface
This sizable section breaks the entire program down control panel by control panel, dialog 

by dialog, and menu by menu, defi ning all controls and options and providing links to the 

relevant instructions.

Designing in PowerPoint for the Best Results in Ovation
• Slide Design: Templates, Layout, and Font Treatment 

• Slide Content 

• Animation and Slide Transitions 

• Revising Slides in PowerPoint and Updating Shows in Ovation 

• Conditions that Cause a Slide to Revert to the PowerPoint Layout 

• File Management 

Advanced Features and Options
Setting Up

• Adjusting Ovation’s Performance to Your Hardware Resources

• Setting Display Options

• Customizing a PowerLook & Fine-Tuning the Treatment

• Disabling and Enabling Slides

• Adding Special Purpose Slides: Walk-In, Title, Intermission, and Walk Out
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• Assigning Deeper Content

• Setting Time per Slide and Target Show Duration

• Preparing the PointPrompter

Presenting
• Scrolling the Note Card, Rolling the Teleprompter

• Going Deeper

• Printing a Presentation
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Appendix: Dual Display Setup

To get the most out of Ovation, you’ll want to operate with two displays — your screen 

with the Ovation interface displayed for just you to see, the other display showing the full 

screen output for your audience to view. That way you’ll have all the advantages of the 

Presenter Panel to aid you.

Setting things up for dual display involves connecting your computer and the secondary 

display device, confi guring Windows display properties for two monitors, and telling 

Ovation what to show on each monitor. Though only the last of these tasks involves 

Ovation directly, we’ll provide a few pointers here that may save you searching for 

instructions elsewhere.

Connecting the Second Display
Physically connecting an external monitor or presentation projector is quite simple 

and typically just requires a standard VGA cable. Some graphics cards displays have 

additional connection options such as S-Video that you can use if both devices have the 

same type of port.

DVI
(Digital Visual Interface)

15 pin VGA
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Display Settings
Once you have the second display device 

connected, Windows needs to know what 

you want to do with it.

1. Select the Settings Tab in the 

Display Properties dialog, which you 

can open through the Start Menu > 

Settings > Control Panel. You’ll 

also fi nd a link to this dialog on the 

Hardware Settings tab of Ovation’s 

Application Settings dialog. 

2. Click the icon for Display Device #2. 

3. Click the check box for the Extend 

my Windows desktop onto this 

Monitor option. 

Do a test run with a show in Ovation to make sure the program’s interface and the full-

screen output are on the appropriate displays. If anything’s awry, then return to the 

Settings Tab of the Display Properties dialog, click the Advanced button, and return all 

driver settings to the defaults. Pay particular attention to settings involving multiple display 

devices. The precise organization of the Advanced Properties dialog and the names for 

various settings vary from one make of graphics card to another. In general, modes with 

words like “Twin” and “Clone” are not what you want with Ovation. With nVIDIA® cards, the 

Dual view setting is a good choice.
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Setting the  Full Screen Output and Ovations Interface to Appear on Monitor 1 
or Monitor 2

When you’re operating with two monitors (or a 

monitor and a projector), Ovation’s interface is 

on Monitor 1 by default while the presentation 

appears full-screen on Monitor 2. You can 

switch these assignments independently on 

General tab of the Application Settings dialog.

To switch the full screen display on and off, 

press the Escape key.
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The Ultimate Video Toolkit
ULTRA 2

ULTRA 2 transforms DV, HDV and HD keying into a practical daily production tool for all types 

of video professionals. Its drag-and-drop simplicity allows video editors to create highly realistic 

background composites that are convincing in every detail, even from marginal video sources. 

Additionally, ULTRA 2 puts high-end virtual sets within reach. Master Sets Libraries (sold sepa-

rately) go beyond typical static shots and include breathtaking fl ying camera shots, moving stages, boom 

and dolly moves. Sets include multiple B-source options and camera angles in tight, medium and wide 

views. These libraries can be used seamlessly in ULTRA 2. 

Professional keying and virtual set 
software for broadcasters and 
video professionals.

Download the free ULTRA 2 Trial Version 
at SeriousMagic.com

DV Rack is the fi rst product that can prevent video disasters, let you 

shoot faster and help you get visibly better quality from your existing 

camera. It’s powerful software that runs on a PC or laptop connected 

to your DV camera. DV Rack puts ten essential production tools 

at your fi ngertips letting you instantly preview, record, review, and 

evaluate your shots.

It’s simply revolutionary.

The biggest revolution in shooting 
since DV itself.

Download the free DV Rack Trial Version 
at SeriousMagic.com

©Copyright 2005 Serious Magic, Inc. SeriousMagic.com

®
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The Ultimate Video Toolkit

Video Presentations in Half the Time 
Serious Magic’s award-winning Visual Communicator 

software makes it easy to create professional-look-

ing  video presentations for education and corporate 

videos. Visual Communicator is based on a creation 

process that produces everything in real time and 

includes an integrated teleprompter that’s perfect for 

narrating your video clips and graphics. Total creation 

time is typically less than 20 minutes and fi nished 

clips can be output immediately in DV and even 

streamed live over the Internet.

Visual Communicator includes everything you’d 

expect from expensive broadcast tools, including 

effortless real-time chroma key, virtual sets with 

refl ections, and real-time 3D digital video effects with 

highlights and soft shadows. Even if you have a room 

full of sophisticated AV equipment, there’s nothing 

that compares to Visual Communicator’s time-saving 

benefi ts. Use it as a standalone tool or import clips 

directly into your editing software, such as Vegas, 

Avid or Premiere, to get professional results faster 

and easier than you ever thought possible.

Create video presentations in 
minutes for business, education 
and personal productivity. 

Download the free Visual Communicator 
Trial Version at SeriousMagic.com

©Copyright 2005 Serious Magic, Inc. SeriousMagic.com

Add video to your blog in seconds! Vlog It is faster and easier than video software because there’s no 

editing required. Use photos, video clips, or record live from a webcam or camcorder into your PC.  It even 

includes a newscaster-style teleprompter for narration. Simply drag and drop to add pictures, video and 

sound clips from your cell phone, digital camera or camcorder. You also get a TV-quality library of graphics 

and titles to help your videos look sensational. It works seamlessly with all top blogging sites, just drop the 

video icon into any existing blog. The impact is not only memorable, it’s inspirational.

Download the free Vlog It 
Trial Version at 

SeriousMagic.com
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Keyboard Shortcuts

File / Presentation Commands

• Open: CTRL+O

• Update from PowerPoint: CTRL+U

• Exit: CTRL+Q

View

• Output on Full Screen: ESC

Presenter/Navigation

• Start from beginning: F5

• Start from Current Slide: F6

• Stop: F7

• Next: Space, N, Enter, Page Down, Right Arrow, Down Arrow

• Back: Backspace, P, Page Up, Left Arrow, Up Arrow

• Previous Revealed Element: CTRL+Up Arrow

• Next Revealed Element: CTRL+Down Arrow

• Next Slide: CTRL+Right Arrow

• Previous Slide: CTRL+Left Arrow

• Jump to Specifi c Slide: Type slide’s number

• Show All Bullets: CTRL+A

• Go Deeper: D

• Black Slide: B

• White Slide: W

Miscellaneous

• Application Settings: Alt+S

• Help: F1

• Start Teleprompter: F9

• Pause Teleprompter: F10


